
 

Essay Writing with Word 2007 

 
Introduction 

 

As a student, you have likely written many types of essays. Perhaps some have been reflection 

papers, outlining your thoughts on a particular topic. Others may have been creative writing 

papers or beginning research papers. In college or university, a formal research paper must 

adhere to strict guidelines for submission. These guidelines include rules for formatting the 

document, and citing the resources used.  

 

There are several standard styles used for citing resources and formatting documents. One of the 

most popular is the MLA style. MLA is an acronym for the Modern Language Association, and 

you will find more information at http://www.mla.org. Other popular standards for citing 

resources include the APA (American Psychological Association – http://apastyle.apa.org) and 

Harvard (author-date) style. Your Professor may require a specific formatting and citation style. 

The required style may be one of the standard styles, or a variation of one of them. 

 

Occasionally you may find yourself collaborating with other students to write an essay or create 

other documentation. Perhaps a classmate proof reads your document and makes suggestions for 

revisions, or you prefer to make notes in the margins while you‟re refining your ideas.  In either 

case, you may find it useful to be able to add comments to a document, and accept or reject 

suggestions for changes to the document.  If you are a professor or instructor, you may wish to 

return a student‟s paper with your comments and/or editing suggestions.  

 

The purpose of this step-by-step tutorial handbook is to provide instructions for using Microsoft 

Word 2007 to format and cite resources in a research essay, and to use the tracking features for 

revisions and adding comments. The MLA style will be used; however the general steps are the 

same for most essay formatting styles. Additional examples using other citation styles will be 

provided as well.  

 

The Essay Outline 

 

To illustrate the essay writing process, let‟s use a hypothetical example. Robin Lew is taking the 

course MUS101 History of Music delivered by Professor N. Harris. Robin must write a short 

research paper, a biography of Ludwig van Beethoven. Robin has done some research and found 

some journal articles, books, web sites and a picture of a piano. Occasionally a professor requires 

students to submit a version of an outline. In any case, Robin prefers to start the writing process 

with a topic outline.  

 

MLA specifies an ordered outline style as follows: 

 

I. Main topic 1 

A. Subtopic 1 

1. Item 

a. Item 

(1) Item 

http://www.mla.org/
http://apastyle.apa.org/


 

(2) Item 

b. Item 

c. Item 

2. Item 

B. Subtopic 2 

II. Main Topic 2 

III. Main Topic 3 

 

Let‟s create an outline for Robin‟s essay. 

 

Hands-on tasks will be denoted by the ► symbol. 

 

► Open Microsoft Word 2007. 

► Set the Font to Times New Roman, and the Font Size to 12, as shown in Figure 1. 

► Click the Center-align button, as shown in Figure 1, to move the insertion point to the center 

of the line. 

► Type: Ludwig van Beethoven Biography Outline, as shown in Figure 1. 

► Press the Enter key to move the insertion point to a new line. 

► Click the Left-align button, as shown in Figure 1, to move the insertion point to the left 

margin. 

 

 
 

Figure 1: Center-align and set the font for the outline title 

 

The multi-level list options do not contain an option with the hierarchy specified by the MLA 

style guide. Although you could reasonably use any appropriate style, let‟s create a multi-level 

style that conforms to the MLA style guide as an example. 

 

► Click the Multilevel List button, as shown in Figure 2. 

► Select the option: Define New Multilayer List, as shown in Figure 2. 



 

 
 

Figure 2: Multilevel List options 

 

The dialog box Define New Multilevel List appears, as shown in Figure 3. 



 

 
 

Figure 3: Define New Multilevel List dialog box. 

 

► Click the Font button to display the Font dialog box. 

► Change the font to Times New Roman, and the size to 12. 

► Click the OK button, to return to the “Define new Multilevel List” dialog box, as shown in 

Figure 3. 

 

In this example, the number style is changed for the first 6 levels only. The number styles can be 

selected from the “Number style for this level” drop-down box. You will need to edit the 

formatting to appear as shown for each level. Let‟s do the first one. 

 

► In the “Click level to Modify” list, click the number 1. 

► In the “Number style for this level” box, click the upper case Roman numeral style as shown 

in Figure 3. 

► Make any editing changes necessary, in the box “Enter formatting for number,” to place a 

period after the Roman numeral. If there are any unwanted characters such as parentheses ( ), 

delete those as well. 

► Similarly, select each of the levels 2 through 6 and select the corresponding number style for 

each as shown in Figure 3, editing the formatting as necessary. 

► Click the OK button after you‟ve made all of the selections for levels 1 through 6. 

 

Now let‟s create the outline. The first numbered bullet is displayed. 

 

► Type: Birth and Family Background 

► Press the Enter key.  



 

Notice that the insertion point moves to the next line, and the next number in the list is displayed. 

Let‟s use a level 2 number for the next point. 

 

► Hit the Tab key. 

Notice that the Tab indents to the next level. 

 

► Hold the Shift key and tap the Tab key. 

 

Notice that Shift+Tab moves the cursor up a level in the multi-list hierarchy. Using Tab and 

Shift+Tab to select the appropriate numbering levels, input the following list: 

 

 
 

Figure 4: Outline using multi-level list 

 

► Save the file as BeethovenOutline.docx. 

 

Let‟s write part of the essay to illustrate formatting, adding sources, citation, and bibliography. 

 

 

 

 



 

Essay Formatting [Move this header to top of next page – do not orphan headers] 

 

MLA recommends the following formatting settings: 

Essay Body: 

 Turn off hyphenation 

 Use 1” margins for top, left, bottom and right margins 

 Use ½” margin for the header 

 Double-space text 

 Do not right-justify the paragraph text 

 Use a good readable font such as Times New Roman, size 12 

 Indent the first line of each paragraph ½” or 5 spaces from the left margin 

 Leave only one space after period or other punctuation 

 Use a header with your last name and page number, aligned to the right margin 

 Quotations 4 lines or less should be encased in double quotes 

 Quotations longer than 4 lines should be offset with a 1” margin from the left and should 

not be encapsulated in double quotes 

 Italicize titles of published works (new for 2009) 

 

First Page: 

 In the upper left corner of the first page list your name, your professor‟s name, the course 

code and the date, double spaced 

 Double-space and center the title 

 Double-space between the title and first line of text 

 Use a header with your last name and page number, aligned to the right margin 

 

Let‟s set up the paragraph formatting, hyphenation, font and header. 

 

► Using Word 2007, open a new document. 

► Set the font to Times New Roman, and the size to 12, as shown in Figure 5. 

► Click the Paragraph button and set the paragraph spacing to 2.0 as shown in Figure 5. 

► Click the Paragraph button and click the option “Remove space after paragraph” as shown in 

Figure 5. [Note: deletion of end punctuation in this section is not correct.  Mea culpa – lm]  

 

By default, Word adds 10 pixels of space between each paragraph. This should be removed; it 

adds unwanted extra space between the double spaced paragraphs. 

 



 

 
 

Figure 5: Setting the font and paragraph spacing 

 

By default, the page margins are set at 1”. You should double-check them in any case. If the 

margins are incorrect you can reset them now. 

 

► Click on the Page Layout tab on the Ribbon as shown in Figure 6. 

► Click on the Margins button as shown in Figure 6. 

► Click on the Normal option as shown in Figure 6. [Retain end punctuation – lm] 



 

 
 

Figure 6: Margin options 

 

Let‟s set the hyphenation option so that words will not be automatically hyphenated. 

 

► Click the Hyphenation button as shown in Figure 7. 

 

 
 

Figure 7: Hyphenation options 

 



 

[MISSING HEADER First Page Setup.] 

► Type: Robin Lew 

► Press the Enter key.  

Notice that the insertion point moves down 2 lines, because the paragraph spacing has been set to 

2.0. 

 

► Enter the professor‟s name, course code and date, as shown in Figure 8. 

 

 
 

Figure 8: First page setup 

 

► After the date, press the Enter key to move the insertion point to the next line. 

 

We will center the title of the essay. 

 

► Click the Home tab and then click the Center-align button as shown in Figure 8, to move the 

insertion point to the center of the line. 

► Type: Ludwig van Beethoven Biography. 

► Press the Enter key. 

► Click the Left align button as shown in Figure 8, to move the insertion point to the left 

margin. 

► Press the Tab key to indent the insertion point by 5 spaces. [Retain end punctuation – lm] 

 

The first line of each paragraph will be indented by 5 spaces. There will not be any extra vertical 

space between paragraphs. 

 



 

► Type the first two sentences of text as shown in Figure 8. Be sure to type only one space after 

the period. Sentences are separated by a single space character. 

 

The Header 

 

The body formatting and title information have been entered, but we still need to add the header. 

This can be done at any time, even after the essay has been completely written. Let‟s do it now, 

though. 

 

► Double-click in the empty area in the top 1” of the document to activate the header area as 

shown in Figure 9. 

 

Notice the header area is activated, and the body of the document is faded. In the ruler bar, notice 

that there are 2 tabs. The center-align tab looks like an upside-down T and the right-align tab 

looks like a reverse L. We will move the insertion point to the right-align tab where we will type 

the author‟s last name and add a page number. 

 

► Press the Tab key twice to move the insertion point to the right-align tab. 

 

 
 

Figure 9: Header area with tabs 

 

► Type: Lew 

► Type a space 

► Click the Page Number button as shown in Figure 10. 

► Click the option Current Position, as shown in Figure 10. 

► Click the option Plain Number, as shown in Figure 10. 

 

► Check the Header from Top value. Ensure that it is .5” as shown in Figure 10. This is the 

margin between the top edge of the page and the header text. 

 

 



 

 
 

Figure 10: Setting the page number format 

 

 

Notice that the page number now appears in the upper right corner. The default font is not Times 

New Roman, so we will have to set the font. 

 

► Select the last name and page number text by dragging the mouse pointer through it. 

► Click the Home tab on the Ribbon as shown in Figure 11. 

► Select the font and size as Times New Roman, 12, as shown in Figure 11. 

 

 
 

Figure 11: Heading font setting 



 

Citations 

 

In an essay, each fact and direct quote must be cited, indicating the resource. The resource could 

be a book, journal article, Web page or some other source. Microsoft Word 2007 has some tools 

for referencing that will be helpful in managing resources and generating automatic citations. We 

will use the MLA style in this example and discuss other citation styles later. 

 

Let‟s continue writing the essay. 

 

► Position the mouse pointer in the body of the document and double-click to activate it. 

► Start a new paragraph, using the Tab key to indent 5 spaces, and type the following sentence, 

as shown in Figure 12. 

 

“Ludwig van Beethoven was baptized in Bonn, Germany, on December 17, 1770. His parents 

were Johann van Beethoven and Maria Magdalena Keverich Leym.” 

 

 

Citing Facts from a Book 

 

This sentence contains factual information, and we must cite the source. Robin found this 

information in the following book: 

 

Title: Beethoven: The Music and the Life 

Author: Lewis Lockwood 

Publisher: W.W. Norton & Co. 

Year: 2005 

ISBN: 978-0393326383 

 

The specific factual information is found on page 551. Let‟s add this book as a resource, and cite 

the book and page number in the paragraph. 

 

► Make sure the insertion point is one space after the end of the sentence as shown in Figure 12. 

► Click on the References Tab. 

► Click the drop-down for the referencing Style and select MLA as shown in Figure 12. 

► Click on the Insert Citation button, and the Add New Source menu item as shown in Figure 

12. [Retain end punctuation] 

 



 

 
 

Figure 12: Add New Source 

 

 

The Create Source dialog box will appear. Enter the information for the book as shown in Figure 

13. Be sure to select the Type of Source as “Book”. Also note that the Author is entered as Last 

Name, First Name. We do not know the city for this publisher, so leave that text box empty. In 

the case where there is more than one author, additional authors can be added using the Edit 

button. 

 



 

 
 

Figure 13: Create Source: Book 

 

 

 

► Click the OK button to create the source. 

Notice that the reference has been added at the insertion point location, as shown in Figure 14.  

We need to edit this to include the page number for this citation. 

 

► Click on the citation to select it, as shown in Figure 14. 

► Click the drop-down arrow to reveal the menu as shown in Figure 14 [Retain end 

punctuation.] 

 

 
Figure 14: Edit Citation 

 

► Click the Edit Citation menu item. 

The Edit Citation dialog box should appear, as shown in Figure 15. 

 

► Enter the page number: 551 

► Click the OK button to complete the edit [Note: end punctuation removed in error.  Either 

would be OK – point is to be consistent. –lm]  

 



 

 
 

Figure 15: Edit Citation 

 

► Click in the document outside of the citation so we can continue to write the essay. 

► Type the following sentence: „Ludwig was a child prodigy pianist and performed his first 

concert in Cologne in 1778.‟ 

 

This fact also requires citation. Its source is the same book, also on page 551. Since the book has 

been added as a resource, we will be able to cite it easily. 

 

► Click the Insert Citation button as shown in Figure 16.  

Notice that the Lockwood book appears in the list of resources. 

 

 
 

Figure 16: Insert Citation listing 

 

► Click on the Lockwood book menu item to add the citation. 

► As before, click the Lockwood citation to select it. 

► Click the drop-down arrow and select the menu item Edit Citation.[Retain end punctuation] 

► As before, the Edit Citation dialog box appears. Enter the page number 551, and click on the 

OK button to complete the citation. 



 

 

Citing Facts From a Web Page 

 

Let‟s continue writing the essay. Robin has found a good quotation to use, that describes 

Beethoven‟s first composition. The quote is from a Web page.  

 

► Enter the following: 

He was also a composer at an early age. “In 1782, before the age of 12, Beethoven published his 

first work: [9 variations, in C Minor, for Piano,” on a march by Ernst Christoph Dressler (WoO 

63).” [should the title of the work be italicized? What does “on a march” refer to?] 

 

We will need to add another resource. This quote is from the following Web page: 

 

Author: Dominique Prevot 

Date: December 2001 

URL: http://www.lvbeethoven.com/Bio/BiographyLudwig.html 

Title: Biography: Beethoven‟s Life – Ludwig van Beethoven‟s website  

Viewed on: June 20, 2009 

 

The title of the Web page is not always found on the page itself. You may find it in the window‟s 

title bar instead of on the page itself, or not at all.  

 

► As before, click the Insert Citation button. 

► Click the Add New Source menu item. 

► In the Create Source dialog box, click the drop-down button for the Type of Source, and 

select Web Page, as shown in Figure 17. 

► Enter the information as shown in Figure 17. You will see the Access Date information, 

which(?) is the date on which you viewed the Web page. 

 

http://www.lvbeethoven.com/Bio/BiographyLudwig.html


 

 
 

Figure 17: Adding a Web page as a source 

 

► Click the OK button to add the source. 

The new citation should appear, as shown in Figure 18. 

 

 
 

Figure 18: Web page citation 

 

Citing Facts from a Journal Article 

 

Robin has found some information about Beethoven‟s teaching experience in a journal article. 

We can add a journal article as a source, using the same technique used for the Web page and 

book. 

 

► Click in the document outside of the Prevot citation and enter the following text: 

“In addition, young Ludwig began teaching piano lessons in 1782 at the age of 12. Through his 

lifetime he taught piano and composition.” 



 

This fact is from the following journal article: 

 

Journal: American Music Teacher 

Volume: April/May 2009 

Article: Beethoven the Teacher 

Author: Eliana Murphy 

Pages: 17 – 21 

 

The specific fact is on page 18. Let‟s add the journal article as a source. 

 

► As before, click the Insert Citation button, and Add New Source menu item. 

► In the Create Source dialog box, click the drop-down arrow for Type of Source and select 

Journal Article, as shown in Figure 19. 

 

 
 

Figure 19: Creating a Journal Article source 

 

We will need to add the month of the publication but the month is not shown in the default fields.  

Let‟s display the additional fields. 

 

► Click the checkbox entitled “Show All Bibliography Fields” to show all of the fields, as 

shown in Figure 19. 

► Enter the journal article information as shown in Figure 19. 



 

► Click the OK button to add the source. 

► As before, edit the citation to indicate page 17 as the source of the fact. 

 

The citation should appear as shown in Figure 20. 

 

 
 

Figure 20: Journal article citation with page number 

 

Formatting Long Quotations 

 

Occasionally it is necessary to include a long quotation. If the quotation is more than 4 lines 

long, it should be indented, without quotation marks. The first line of any paragraph in the long 

quotation should be indented by ¼” as well.  

 

Let‟s add a long quotation and format accordingly. The quotation we will use begins with the 

first line of a paragraph in the original source. Thus we will need to indent the first line of our 

quotation. MLA style specifies that the entire quotation should be indented 1” from the left 

margin of text. 

 

► Press the Enter key, then type the following as a new paragraph in the essay. Use the Tab key 

to indent the first line, as shown in Figure 21: 

 

“Ludwig van Beethoven was a dedicated teacher but on occasion he was more focused on 

composition.” 

 

 
 

Figure 21: New paragraph 

 

Now we‟re ready to enter the long quotation. 

 

► Press the Enter key to move the insertion point to the next line and enter the following text: 

 



 

“Beethoven was mostly regular about giving lessons, but occasionally he missed one when 

occupied with composing or preparing for a concert. Also, when he was a young man, he would 

sometimes miss lessons out of laziness. He frequently met with students more than once a week; 

once he gave Therese and Josephine von Brunsvik a lesson every day for 16 days without 

missing a single one.” 

 

We will use the paragraph alignment markers on the ruler bar to set the margin and indent for 

this paragraph. 

 

► Ensure the insertion point is located in the quoted paragraph. 

► Drag the paragraph markers as shown in Figure 22. This can be tricky! Drag the Left Indent 

marker to the 1” position first. Then drag the First Line Indent marker to the 1.5” position.  

 

 
 

Figure 22: Paragraph indent markers 

 

Let‟s add the citation. This quote is from the journal article, on page 18. 

 

► Position the insertion point one space after the period in the last sentence. 

► Click the Insert Citation button and select the Eliana Murphy resource. 

► Edit the citation to add page 18 to the reference. 

► Click to the right of the citation to return to editing the document. 

► Press the Enter key once, and then press the Backspace key to move the insertion point to a 

new line in the outer paragraph. 

► Enter the following text to complete the paragraph: 



 

“His dedication is illustrated by providing lessons for 16 days without a break and meeting with 

students more than once each week.” 

 

 

Notice that the new page has the heading and page number in the upper right corner, as shown in 

Figure 23. 

 

Citing an Illustration 

 

Occasionally it is useful to include an illustration in an essay. The citation for the illustration can 

be placed in the caption for the illustration. Robin has used a digital camera to take a photograph 

of part of a piano keyboard and would like to include this image in the essay. You can practice 

this exercise using a picture of your own, or use a Clip Art picture in Word 2007. 

 

Illustrations are labeled in the caption below the image as Fig. with an Arabic numeral. We will 

label our illustration as Fig. 1. 

 

► In a new paragraph, enter the following text: 

The piano is a large instrument that consists of a case, strings, and a keyboard. The modern piano 

has a keyboard that consists of white keys and black keys, as shown in Fig. 1. 

 

An illustration should be aligned with the left margin and requires a caption below the 

illustration. The source information can be cited in the caption. In this case, Robin took the 

picture, so we will cite Robin as the creator. 

 

► Click the Insert tab on the Ribbon and click the Picture button, as shown in Figure 23. 

 

 
 



 

Figure 23: Insert Picture and page 2 

 

 

The Insert Picture dialog box will open, as shown in Figure 24.  

 

► Search your computer to find a suitable picture, and select the picture, as shown in Figure 24. 

► Click the Insert button to insert the picture in the document. 

 

 

 
 

Figure 24: Insert Picture 

 

The picture may be quite large, or you may wish to change the size of the picture.  

 

► You can drag the handles to change the size of the image.  

The handles are shown in Figure 25. 

 



 

 
 

Figure 25: Image handles and illustration caption 

 

 

► Once you‟re satisfied with the size of the image, click to the right of the image to edit the 

document. 

► Press the Enter key to move the insertion point below the image. 

► Type the following text, as shown in Figure 25: 

 

“Fig. 1. Part of a piano keyboard. Source: Robin Lew, photographed June 2009” 

The source is identified as Robin Lew, with the date the picture was photographed. Since the 

source is identified in the caption, it will not need to be listed in the references later. 

 

The List of Works Cited 

 

Robin has completed enough of the essay for now and would like to create the list of works 

cited. This list may be called the “Bibliography”, or “References”, but MLA recommends the 

title “Works Cited”. The Works Cited section should be at the end of the paper, on a new page. 

 

► Press the Enter key to move the insertion point below the caption of the image. 

► Use the Ctrl+Enter combination to insert a page break. 

Notice that a new page appears, with the heading and page number in the upper right corner. 

 

► Click the Home tab on the Ribbon, as shown in Figure 26.  

► Click the Center button, as shown in Figure 26. 

► Type: Works Cited 

► Press the Enter key to move the insertion point to the next line. 

► Click the Left Align button to move the insertion point to the left margin, as shown in Figure 

26. 

 



 

 
 

Figure 26: Works Cited new page 

 

The good news is that Microsoft Word 2007 has a Bibliography generator. This will save some 

time and frustration; however, the bad news is that it‟s not quite perfect. We will need to modify 

the formatting of the sources to conform to MLA. 

 

► Click the References tab on the Ribbon as shown in Figure 27. 

► Click the Bibliography button, and select the menu option Insert Bibliography as shown in 

Figure 27. 

 



 

 
 

Figure 27: Insert Bibliography 

 

The list of sources is placed in the document at the insertion point. In order to format the listing 

to conform to MLA, we will need to change the font to Times New Roman, 12 point, set 

paragraph to double-space, and add a ½” hanging indent. The 2009 MLA formatting 

recommendation for titles is italics rather than underlining, so we will need to change that as 

well. 

 

► Drag thought the listing of resources to select the entire list. 

► Click the Home tab on the Ribbon, and select the font Times New Roman, 12 point. 

► Change the formatting of each title from Underline to Italics (drag through each title, one at a 

time, click the Underline button to turn off underlining, and click the Italic button to turn on 

italics). 

 

When we formatted the long quotation, we used the paragraph markers to indent the first line and 

adjust the left margin of the paragraph. Let‟s use the same technique, but this time the first line 

will “hang” and the rest of the paragraph will indent. The hanging indent formatting is required 

for resources that require more than one line. The last resource extends two lines, so we will see 

this effect only with the last one. 

 

► Drag through the information for all of the resources, to select them.  



 

Even though only one resource extends beyond one line, we might as well format all of them in 

case we edit information later. 

► Drag the hanging indent marker to the ½” mark, as shown in Figure 28. This is tricky. Be sure 

to drag only the triangular hanging indent marker, and not the rectangular left margin marker as 

identified below.   

 

 
 

Figure 28: Hanging indent. 

 

If you find that using the ruler bar is tricky, you can set a hanging indent using the paragraph 

dialog box. You can click the Paragraph button to display the Paragraph dialog box as shown in 

Figure 29. You can set the hanging indent using the Paragraph dialog box, as shown in Figure 

29. 

 



 

 
 

Figure 29: Paragraph dialog box 

 

Finally, let‟s set the paragraph spacing. 

 

► Drag through all resources to select the entire list. 

► Click the Paragraph button, and click the 2.0 menu item as shown in Figure 30. 

► Click the Paragraph button and click the menu item “Remove Space After Paragraph” as 

shown in Figure 30. 

 



 

 
 

Figure 30: Paragraph spacing for Works Cited 

 

The 2009 MLA guidelines also require us to add the medium of publication. A book would be a 

print publication, and an electronic resource accessed via the Web would be a Web publication. 

If the resource is a Web publication, we must also include the date on which the resource was 

viewed.  

 

The Lockwood book is a print publication. The Murphy article was viewed on the Web on June 

20, 2009. The Prevot Web site is a Web publication. 

 

► Edit the resources to include the publication media as shown in Figure 31. 

 

The completed Works Cited list is shown in Figure 31. 

 

 



 

 

Figure 31: Completed Works Cited page 

 

Microsoft Word 2007 Tracking Features 

 

 

Robin‟s friend, Leslie, will proof-read the essay, using the tracking features to make suggestions 

for changes and to add comments. The tracking feature will track any changes made to the 

document.  Each change can be accepted or rejected individually. All changes can be accepted or 

rejected in one step as well. Separate from tracking changes, a comment can be inserted in the 

document and comments can be deleted individually or all together. 

 

Let‟s add some comments, and make some editing changes to the essay. Comments can be added 

at any time, and the track changes feature does not need to be enabled in order to use the 

comments feature. Since Leslie is going to be proof-reading, however, it‟s just as easy to enable 

the track changes feature now. 

 

► Move the insertion point to the top of the document. 

► Click on the Review tab, as shown in Figure 32. 

► Click on the Track Changes button, and select the menu item Track Changes, as shown in 

Figure 32. 

 

 
 

Figure 32: Turning on the Track Changes feature 

 

 

 

 

 

Leslie doesn‟t like the title that Robin chose, but doesn‟t really have a suggestion for a new one. 

Leslie would like to make a comment regarding the title. 



 

 

► Move the insertion point to the end of the title. 

► Click the New Comment button, as shown in Figure 33. 

Notice the comment bubble has appeared to the right of the right edge of the page. The comment 

bubble may contain your initials or the initials of the owner of the computer you are using. 

 

► In the comment, type: “Suggest you use a catchy title. This one is a bit boring.” 

This is shown in Figure 33. 

 

 
 

Figure 33: Insert Comment 

 

Figure 34 shows the editing changes and an additional comment. 

 

► Drag through the title, “Ludwig van Beethoven Biography” and change the text to Arial, 16 

point. 

Notice the comment bubbles have appeared, listing the formatting changes, as shown in Figure 

34. 

 

► Click after the word “pianist” to move the insertion point and type: “and teacher” 

This is shown in Figure 34. Notice that inserted text is underlined, and a vertical line has 

appeared in the left margin. 

 

► Click after the word “composer.” And type: “His music is enjoyed today.” 

►Similarly, insert the word “essay” after the word “This” in the first paragraph. 

► Delete the word “brief”. 



 

Notice the deleted words are displayed with strike-through, as shown in Figure 34. 

 

► After the word “Cologne”, type: “, Germany” 

► After the word “age”, add the following comment: “What age?” 

 

 
 

Figure 34: Editing changes 

 

Be sure to save the document. The editing changes will be saved in this tracking format. The 

editing changes can be viewed using several options. The default option shows all comments and 

formatting in bubbles, and text changes inline, displaying the document‟s final look. We can 

display the original, with or without tracking changes and the final with or without tracking 

changes. Let‟s change the view. 

 

► In the Display for Review drop-down box, select the option Final, as shown in Figure 35. 

 

 
 

Figure 35: Display for Review drop-down menu 

 

Notice the inline editing changes and comments have disappeared, and the document is displayed 

showing the effect of all changes. The changes have not been accepted, however, and we can 

display them again. The markup refers to the inline editing changes. Final and Original refer to 

the document with or without the editing changes. Thus the Final Showing Markup view would 

be the document as it would look after editing changes, showing the inline editing changes. The 



 

Original Showing Markup view would be the document as it looked originally, with added inline 

editing changes. 

 

► In the Display for Review drop-down box, select the option Final Showing Markup. The view 

should look as it did in Figure 34. 

 

Now, let‟s accept and/or reject changes, and delete the comments. 

 

► Click on the first comment to select it, as shown in Figure 36. 

► Click on the Delete comment drop-down button, and select the Delete option as shown in 

Figure 36.  

 

Notice that the comment has been deleted. This method will delete an individual comment. The 

menu item Delete All Comments in Document, will delete every comment in the document.  

 

 
 

Figure 36: Delete comment 

 

Let‟s reject the font formatting change. MLA recommends the Times New Roman 12 point 

formatting that was used previously. 

 

► Click the Formatted bubble to select it, as shown in Figure 37. 

► Click the Reject drop-down button and select the option Reject and Move to Next as shown in 

Figure 37. The Reject Change option will reject the current change, but will not select the next 

change. 

 



 

 
 

Figure 37: Reject change and move to next 

 

The font formatting should have been removed and the next change in the document should be 

selected, as shown in Figure 38. 

 

Let‟s accept the next change, which inserted the text “, teacher”.  

 

► Click the Accept button and click the option Accept and Move to Next, as shown in Figure 

38. The Accept Change option would accept the selected change, but not select the next change. 

 

 
 

Figure 38: Accept change and move to next 

 



 

Notice the change has been accepted and is now displayed as text instead of as markup. We 

could select each change individually and accept or reject, but this can become quite time 

consuming. Instead, it is much more expedient to reject any changes as appropriate, and then 

simply accept all changes that are left. If you foresee rejecting more changes than accepting, the 

opposite could work as well; accept changes individually, then reject all leftover changes at once. 

 

Let‟s accept all of the remaining changes. 

 

► Click the Accept button, and select the option Accept all Changes in Document, as shown in 

Figure 39. 

 

 
 

Figure 39: Accept all changes in document 

 

Notice all changes have been accepted and converted to text. However, the comment still 

remains because a comment is not a change. 

 

► Select the comment and delete it using the Delete comment drop-down as we did previously. 

 

 

Using Other Citation and Bibliography Styles 

 

Thus far, we have used the MLA citation and bibliography style.  Once citations and the 

bibliography have been added, the style can be changed easily. However, you will find that the 

Works Cited page will have to be reformatted with double-spaced paragraphing, hanging indent 

and Times New Roman font. 

 



 

Let‟s change the style to APA (American Psychological Association), another common citation 

style. 

 

► Click the Style drop-down and select APA, as shown in Figure 40. 

 

 
 

Figure 40: Change the Style to APA 

 

There may be a slight delay after you make this selection, as Microsoft Word 2007 changes each 

citation in the document, and changes the bibliography formatting as well.  

 

Notice the citation formatting has changed for each citation. For instance, (Lockwood 551) has 

been changed to (Lockwood, 2005, p. 551). The Works Cited page has been reformatted to the 

default formatting, and this would have to be changed manually to use hanging indents, double 

spaced paragraphs and Times New Roman font. 

 

► Use the Undo feature to undo the APA citation change and return to the MLA citation style. 

 

There are some additional citation styles that are not included in the Microsoft Word 2007 list. If 

you require a citation style that is not in the list, one option is to convert all citations to plain text 

and edit them manually. Sometimes add-in products are developed to augment the features of a 

software product. In this case, an Open Source application called BibWord has been developed 

to extend the citation and bibliography styles for Word 2007. Add-on styles and information for 

installation can be found at http://bibword.codeplex.com/. 

 

 

 

 

 

 

 

http://bibword.codeplex.com/

